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Handling Fundamentals
1.1 Minimize / Expand Toolbar

Most of the ChessBase commands and functions can be found in the upper 
toolbar. There is a toolbar in the main ChessBase window (database win-
dow) as well as in the board window, however with different tabs and com-
mands/options adapted to suit the context on it. The toolbar in ChessBase 
can be compared to the menu bar in Microsoft Office programs.

In order to have more space to work with in the main area, you can choose 
to minimize the toolbar. In the minimized state, only the names of the tabs 
are visible. To minimize a toolbar, use the right mouse button to click an-
ywhere on the bar and then use the left mouse button to click Minimize 
Ribbon 1 in the context menu that appears.

Toolbar of the database window, right-hand side

To temporarily display a tab of a minimized toolbar, simply click on its name. 
After selecting the desired command, the tab is automatically hidden again.

To show a minimized toolbar completely at a later time, right-click again on 
the section which is still visible – for example, on one of the tab names – and 
then left-click on Minimize Ribbon (in the minimized state there is a tick in 
front of this command).

The Simplify Ribbon 2 option in the toolbar context menu is a new feature 
in ChessBase 17. The tabs are still displayed, however the icons on them are 
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Customizing Quick Access 
much smaller and without labels. The tooltips are still available – simply 
hold the mouse over an icon to see its description. If the simplification of the 
toolbar is activated, you can also see this in the context menu by the tick in 
front of the command. If the need be click on it again to restore the old state 
(full-size toolbar). 

Simplified ribbon in the board window

1.2 Customizing Quick Access

At the top left of the database window and in all other windows (board win-
dow, games list window) you will find a small toolbar, Quick Access. This is 
initially only filled with a few icons, of which it can be assumed that most 
users will frequently need the commands/functions they represent. If you 
often work with Quick Access, you can expand this toolbar as you wish or 
simply remove symbols that are not needed.

Some frequently used commands are offered by Quick Access directly in a 
menu that opens when you click on the icon on the far right with the arrow-
head pointing down (if you hold the cursor over it, the tooltip Customize 
Quick Access appears). The following illustration shows this menu in the 
board window. The ticked commands are in the Quick Access toolbar. 
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Handling Fundamentals
If you select a command 
without a tick in the open 
menu Customize Quick Ac-
cess, the corresponding icon 
is added to Quick Access. Se-
lecting a ticked command 
removes the corresponding 
icon from Quick Access.

In order to add commands/
options that ChessBase does 
not provide in the menu Cus-
tomize Quick Access, simply 
locate the command or the 
corresponding icon button in 
the toolbar and access it via 
right-click on the mouse. As a 
result, a context menu ap-
pears; select the command 
Add to Quick Access.

This same command is not 
only available in the toolbar, 
but also in the file menu, as the 
following illustration shows 
for the database  window. 

Quick Access toolbar with the opened menu Cus-
tomize Quick Access in the board window
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Customizing Quick Access 

In this illustration the context menu command Add to Quick Access adds an icon for creating 
a new database to the Quick Access.

You could also right-click directly on File/New without opening the sub-
menu to add the icon for creating a new database in Quick Access. In this 
case ChessBase always takes the default command when executing Add 
to Quick Access, which is always the first command of the submenu (in 
this case File/New/Database).

For example if you want to add a symbol for building a new position to 
Quick Access, you have to right-click on Position Setup in the File/New 
submenu and select Add to Quick Access in this context menu.
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Working with Databases
2.1 Adding Databases to the "My Databases" View

The database window is the central point for ChessBase. The display with 
the two-part view is modelled on Windows Explorer. In the left-hand win-
dow area labelled Folders, you will also find all system paths, as in Windows 
Explorer, including the OneDrive folder and a network folder through which 
you may also have access to databases on other computers in your local 
network. In addition, there are special entries for ChessBase folders and 
directories specifically intended for chess databases. These are mainly the 
Database path 1 with its subfolders Bases, Books, Cloud, CompBase etc. 
and the view My Databases 2.

Following Windows terminology, the left window area of the database 
window is called database explorer or ChessBase explorer.

In the My Databases view you can manage all the databases you often work 
or those that are important to you. To add a database symbol for an existing 
database to the My Databases view, open the database from this view:

1

2

3

4
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Adding Databases to the "My Databases" View 
1 Select the entry My Databases 2 in the database explorer, in the left 

area of the database window. You can also click on the My Databases 
icon 3 on the Home tab to switch to the My Databases view.

2 Then right-click on a free space in the right-hand area and select Open 
Database in the context menu. Alternatively, press Ctrl+O.

3 The Select Database dialogue box appears. Select the desired data-
base, for example the corresponding .cbh file, and click Open.

ChessBase then opens the database and adds an icon for the database to 
the My Databases view simultaneously.

Even if you create a new database, it will always be added automatically in 
the My Databases view. It does not matter whether you use the command 
New Database 4 in the context menu of the view My Databases (illus-
tration left page) or, for example in the File menu (see also "2.5 Creating a 
new Database" on page 46).
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Working with Databases
Besides the one shown, there is 
another drag and drop method 
to add a database icon to the 
My Databases view. It may 
even be more convenient and 
without "side effect" – that 
means the database does not 
open: Simply drag the data-
base symbol with the mouse 
onto the My Databases entry 
in the database explorer. Once 
there, release the mouse but-
ton. While dragging, keep the 
left mouse button pressed. You 
need not press an additional 
key on the keyboard.

In the illustration above, the icon of the Mega Database 2023 5 is dragged 
onto the entry My Databases 6. For this icon to be displayed in the main 
area, you must select the folder in which the database is stored in the data-
base explorer, here Bases 7. 

To remove a database symbol 
from the My Databases view, 
click on it with the right mouse 
button, select the command Re-
move in the context menu, and 
confirm the prompt with OK (this 
command only removes the da-
tabase symbol from the view; 
the database remains un-
changed).

5

6

7

8



39

Where Should Specific Databases be Stored? 
WARNING: The command Delete All Files 8 (see illustration on the left) 
not only removes the database icon from the My Databases view but also 
physically deletes the entire database. It is therefore advisable not to use 
the shortcuts Delete and Shift+Delete for the commands Remove and 
Delete All Files, as they can be confused more easily.

2.2 Where Should Specific Databases be Stored?

Of course, you can store your databases anywhere you like, for example on 
an external hard drive, on a USB stick or in the cloud. However, ChessBase 
provides a special folder as the default folder for databases. If you did not 
specify anything else during the installation of ChessBase, it is located in 
the Documents folder of the user directory; the path is therefore, for exam-
ple, C:\Users\<username>\Documents if your root drive is C:. The folder is 
named like the program itself, namely ChessBase.

ChessBase database path in Windows 10 (the user name here is Walter).

The database path, thus the path to the ChessBase folder, is also displayed 
in the database explorer of the database window, the entry is at the top 1.  
If you click on it, you will see all the subfolders of the ChessBase database 
folder in the window area next to it 2. In addition, these also appear directly 
in the database explorer if you expand the node next to  Database path 3. 
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Tips for Working in the Board Window
3.1 Entering a New Game and Saving it in a 

Database

To enter a new game, first open an empty 
board window. To do this, either click on the 
board symbol 1 on the Home tab or press 
Ctrl+N.

A new ChessBase application window with a 
chess board and the pieces in the home posi-

tion appears – the main ChessBase window (the database window) remains 
open. To make a move, grab the piece (pawn, knight, etc.) with the mouse 
– you click on it with the left mouse button and hold it down – and drag it to 
the target square. Once there, release the mouse button. In concrete terms: 
To enter the move 1. e2-e4, for example, click on the 
square e2, keep the mouse button pressed and drag the 
pawn to e4, where you release the mouse button again.

When you have finished entering the whole game, click 
on File and then on Save (no further selection in the 
submenu is necessary, as ChessBase uses the Save 
Game option by default). Alternatively, press Ctrl+S or 
click on the floppy disk icon 2 at the beginning of the 
Quick Access.

You could also use the Save Game as command in the menu for the File 
button with the same result. However, this command is intended to save 
an already saved game – for example after a change – again, as another 
game, whereas the simple command Save overwrites an already saved 
game after a change, i.e., it replaces the game. Since the game is not yet 
saved when you enter a new game, it does not matter which of the two 
commands is used.

1

2
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Entering a New Game and Saving it in a Database 
In the dialogue box that appears, select the database in which you want to 
save the game and click OK. Then you can enter the game data in anoth-
er dialogue box that appears, for example, the names of the players, the 
tournament, the date on which the game was played (by default the current 
day), the ECO code of the opening played, etc. In this dialogue box, enter the 
information that is important to you. In the left-hand area, select the indi-
vidual categories 3 one after the other to see all the possible entries. The 
buttons labeled Details 4 open additional dialogue boxes in which you can 
make even more detailed entries in relation to an adjacent input field (in the 
picture Tournament).

Before saving, enter all the information about the game that is important to you.

Confirm your entries for the game again with OK. ChessBase will then save 
the game in the previously specified database. 
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Tips for Working in the Board Window
3.2 Special Methods for Inputting Moves

ChessBase offers some shortcuts with which you can enter moves rather 
quickly. For example, if you click directly on the target square and hold 
down the mouse button, ChessBase will outline a piece that could move 
there. In the position shown in the following diagram, the queen, the pawn 
on f7 and the knight on g8 could move to f6. That's why ChessBase out-
lines these three pieces when you click on this square and hold down the 
mouse button.

When there are several possible moves, ChessBase prioritises one move and 
marks the corresponding piece – in the illustration the knight on g8 – with 
a grey circle 1. In fact, a good chess player in the above position will un-
doubtedly prefer the move Ng8-f6 to the moves Qd8-f6 and f7-f6. To make 
a move suggested in this way, it is sufficient to release the mouse button on 
the square.
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Special Methods for Inputting Moves 
To make one of the other possible moves, press – one after the other, if nec-
essary – the right mouse button while holding down the left mouse button 
and release both mouse buttons as soon as the matching figure is outlined 
by the grey circle. Alternatively, move the mouse to the matching figure and 
release the mouse button there. For example, to enter the move Qd8-f6 in 
the position above, you can proceed as follows:

 X You can click in the square f6, keep the left mouse button pressed, then 
click once with the right mouse button so that ChessBase places the 
grey circle on the queen, and then release both mouse buttons.

 X You can click in the square f6, keep the left mouse button pressed, move 
the mouse over the square d8 and release the mouse button there. The 
right mouse button is not used in this method.

If you already know or have an idea of which move ChessBase will suggest 
or if only one piece can move to a particular target square and you therefore 
do not want to display the figure outlines, you can simply click once on the 
target square without holding down the mouse button. For example, in the 
initial position you only need to click briefly on the square e4 to execute the 
move 1.e2-e4.

But it also works the other way round. That is, when you click on a piece you 
want to move (the cursor takes the form of a hand in this case), ChessBase 
marks the target squares in question. The following illustration shows the 
same position as in the previous picture but with the knight on g8 being 
clicked. Since in this position the moves Ng8-e7, Ng8-f6 and Ng8-h6 are 
possible with this piece, ChessBase marks the corresponding target squares 
e7, f6 and h6.
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Special Functions
5.1 Null Move

When entering a move for White or Black, you can, if necessary, make one 
or more moves in succession without making a countermove. This can be 
useful, for example, if you want to analyse the same position with one move 
more or one move less, or if you want to compare the current position with 
a slightly different one.

To enter a so-called null move, click on the Enter Null Move icon 1 on the 
Insert tab of the board window. Alternatively, press Ctrl+Alt+0. 

For example, if you have just made a regular move for White and want to en-
ter another move for White immediately afterwards – without a black coun-
termove – then use a null move for Black. 

If you want to enter several "free moves" for White all at once, then click on 
Enter Null Move after the regular move (or press Ctrl+Alt+0), execute the 
desired move, click on Enter Null Move again, execute the next move for 
White and so on. ChessBase inserts two hyphens in the notation for each 
null move 2 (illustration next page). 
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Merging Games 

Here White has executed the moves 4.d2-d3 and 5.0-0 in succession.

5.2 Merging Games

You can merge two or more games into a single variation tree by selecting 
them together in a games list and then pressing the enter key.

Pressing the Enter key merges the selected games into a single new game.
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Special Functions
The following notes apply to this:

 X The merged games are displayed in a new board window and are not 
yet saved. When you close the board window, however, you will auto-
matically be asked to do so. Click Yes if you want to save the variation 
tree permanently as a new game, or click No to discard it if it was only of 
temporary interest to you.

 X The first of the games selected in the games list is always set as the root 
game for the variation tree to be created. The game data is also taken 
from this game. In the illustration above, for example, this is the game 
with the number 3 (White: Radjabov, Black: Carlsen) 1 (previous page).

 X Note, however, that "the first game" always means the game that is 
on top of the games list. If you do not sort the games by number (first 
 column) but by another criterion (for example, by date or by the Elo rat-
ing of the White or Black players), this can be a different game.

 X If move sequences/variations of the selected games overlap, they are 
sensibly taken over only once for the resulting variation tree; this applies 
to main variations as well as to side variations. If, for example, all the se-
lected games begin with the moves 1. e4 c5 2. Nf3 Nc6 3. Bb5, then this 
results in only one variation, not the same one three times. However, it 
can become a bit problematic or confusing if such an overlapping move 
is annotated in several of the selected games. In this case, all the anno-
tations are combined into one annotation by appending them to each 
other without separators. If, for example, the move 3. Bb5 is annotated 
in one of the selected games with White is willing to give up his bish-
op pair and in another with White may give up the bishop pair, then 
the resulting variation tree will contain the following comment for this 
move: White is willing to give up his bishop pair White may give up the 
bishop pair. You may want to adjust such composite annotations if you 
want to save the variation tree permanently as a new game.
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Inserting Variations by Drag and Drop 
5.3 Inserting Variations by Drag and Drop

If you want to add a variation to a game that already exists in another game, 
you can save yourself the trouble of entering the moves manually. Simply 
drag the desired variation from the notation of one game into that of the 
other game with the mouse. To show you exactly how this works and what 
results you can expect, here are a few small examples:

1

Proceed as follows if you want to add to the demo game 1 (left board win-
dow of the above illustration) the variation of demo game 2 starting with 
the move 5... d6 (right board window) 1: 

1 Arrange the two board windows with the games next to each other as 
shown in the illustration. The two board windows do not necessarily 
have to be at right angles to each other as in the illustration, they may 
overlap. The only important thing is that the notations of both games 
can be seen. 

2 Now click on the move 5... d6 
in the board window of demo 
game 2, i.e. on the first move 
of the variation to be added to 
demo game 1, but do not re-
lease the mouse button.

1
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